Getting Started with Blackboard

To Login to Blackboard

i . Have an Account? Login Here.
1. Navigate to http://blackboard.ucc.ie/.
2. Click the Login button. R b A
button below. Othenvise, leave blank and
3. Type the Blackboard UserID and Password you have sl anetharoption fofhe feft
been issued with into the relevant boxes and click the ITSER“*‘“"E:
Login button.
PASSWORLD:
4. The UCC Blackboard portal opens as displayed below. !
Forgot your pasaword? Login J
Tabs to access different
interfaces to Blackboard The Menu Bar appears
\ \ throughout Blackboard
E UNIVERSITY COLLEGE, CORK =
Caljiste na hOllscoily Corcaigh
= Home Help Logout

UCC Blackboard Courses Acaderic Web Res

Welcome, UCC Covout
& Announcements
B Calendar My Announcements @ My Courses @ @
@ Tacks Mo system announcements have been posted Courses in which you are enrolled:
B iew Grades today. Fd UCC Blackboard Users Group Forum
bd Send E-mail mare. .. Mo Announcerments.
& User Directory Courses you are teaching:
Address Book My Calendar ) i Introduction to Blackboard
%l‘ow A Mo calendar events have heen posted today. Mo Announcernents.
rmare. ..
My Tasks (=)
Mo tasks due.
A mare.
Built-in Tools Course Area

To Change your Password

1.

2
3.
4

o

Click on the UCC Blackboard tab.
Click the Personal Information link in the Tools box on the left.
Select the Change Password option.

Type your new password in the upper box. Repeat the new password in the
lower box.

Click Submit.

_ _ L@ Change Password
The message (right) should appear. Click OK.

User updated
Faszword successfully updated.
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Getting Started with Blackboard

Announcements: Details of all institution-wide announcements & Arnouncements
along with those of all courses you are registered on. Bl Calendar
. B Tasks

Calendar: Display your calendar, events and announcements.

A iew Grades
Tasks: A scheduling facility that can be used within courses also bd Send E-mail
useful as a personal tool. & User Directory

. . . Address Baok

View Grades: Access grades from course quizzes/assignments. -

E Personal
Send E-mail: Allows access to the Send Email facility of each Information

course you are registered on.
User Directory: Searchable index of users currently registered on the system.
Address Book: A store for details of contacts and email addresses.

Personal Information: Options to change your password, amend your personal
details, and choose how much information about you appears in the User Directory.

To Edit your Personal Information
1. Click on the UCC Blackboard tab.

Click the Personal Information link in the Tools box on the left.

Click the Edit Personal Information link and fill in the remaining fields.
Click Submit.

Review the information and click OK. (Repeat steps 3-5 if you wish to make further
changes.)

a > wn

The Courses Tab

The Courses tab provides a Course List displaying the courses on which you are
enrolled, whether as an instructor or a student. The Course Catalog provides
access to listings of courses currently available on UCC Blackboard.

Ucc Blackboard Courses Academic Web Resources

& cCourse List [ Course Catalog

Course Search

—

advanced search

Courses you are teaching: b Browse Course Catalo

EEl Introduction to Blackhoard

Course [D: BB0Z
Instructar(s):  Learning Technologies Unit UCC
ICC Blackboard

Courses in which you are participating:

UCC Blackboard Users Group Forum

Course 1D: UCCBUG
Instructors): Learning Technologies Unit UCC
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Getting Started with Blackboard

The Academic Web Resources Tab

UCC Blackboard

STER 98

Ar and Music
Business and Managerment
Computer & Engineering

Caurses Acadernic Web Resources

The Blackboard Resource Center provides users with a Cornputer and Information Technology

Education

wealth of academic resource information. These TR
resources are maintained by Blackboard Inc. Languages

Legal

Literature and Linguistics
Mathematics

Click on a category, and then select a discipline from the Wledicine & Health

selection offered.

Physical Education
Science

Social Sciences and Social Study
“ocational

INSTRUCTOR CONTROL PANEL

All course administration is carried out through the Instructor Control Panel.

COURSES » INTRODUCTION TO BLACKBOARD > CONTROL PANEL

BB0Z: Introduction to Blackboard - UCC Blackhoard (Instructor)

Manage Tools
Settings

Course Information Assighments List / Modify Users Remove Users from the Course
Course Documents Books Enroll User Manaye Groups

External Links
Test Manager Gradebook

Announcements Discussion Boards Survey Manager Gradebook Views

Course Calendar Send E-mail Pool Manager Course Statistics

Staff Information Collahoration

Tasks Digital Drop Box

Support

Manual

Manage Course Menu Import Course Cartridge Contact System Administrator

Archive Course Import Package

Recycle Course Resources

Export Course

Control Panel Function Areas

Content Areas

Tools necessary to add text, files, and information into your
course.

Course Tools

Communication tools for instructors to send email, create
tasks, and work with groups.

Course Options

Security and customisation options for advanced
management of course components.

User Management

Tools for the instructor to manage users and enrolments.

Assessment

Tools for building assessments, recording grades, and
tracking user activity.

Support

Support contacts and online documentation.
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Getting Started with Blackboard

Accessing your Course

o From the UCC Blackboard tab, click the name of the course you wish to access
in the My Courses box.
OR

¢ Click the Courses tab, and select the name of the course you wish to access
from the Courses you are teaching list.

The Course Menu External Links
Tools

1. Click Control Panel at the bottom of the menu on the left.

Bb Student Guide

@ Course Map

2. Select Manage Course Menu from the Course Options box.

» Default menu options are as follows: control Panel
Content Area Description
Announcements Announcements relating to your module can be posted in this

area. The Announcements are the first thing a student sees
on entering your course.

Course Information | This area is used to display descriptive information related to
a course, e.g. objectives, timetables, syllabus, exam dates.

Staff Information Contact information and hours can be posted in this section.

Course Documents | Learning materials such as lecture notes, overheads, and
multimedia clips are posted here.

Assignments This area lists the due date and description for class work.
Files can also be attached to posted assignments.
Communication Those enrolled on the course can communicate with each

other in various ways:
« Send & Receive Email via UCC Student email accounts
« Discussion Boards
o Collaboration Sessions:
« Virtual Classroom or Lightweight Chat
« View the Roster of those enrolled on the course
» View Group Pages where a lecturer has created groups for
project work

Discussion Board Read and post messages to Discussion Boards created by
Instructors for the class.

External Links Build your own selection of hyperlinks to outside learning
materials.
Tools Student Tools:

. Digital Drop Box for electronic submission of assignments

« Students can create their own Homepage which can be
visited by those looking up the Roster (within Communication)

« Access Personal Information

« View the Course Calendar

« View course Grades

« Access the Student Blackboard Manual

« View Tasks set by the course Instructor.

« Use the Electronic Blackboard for note-taking

Bb Student Guide A link to UCC's Student Guide to Blackboard

Course Map Navigate the course site using a collapsible tree directory.

Control Panel Instructors can administer their module by clicking this link.
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Getting Started with Blackboard

GROUNDWORK FOR YOUR COURSE

Remove a Link/Button from the Course Menu

If you don’t intend to use a particular link for your course, you can click the Remove
button to the right of it. This will tidy up the Course Menu on the left of the course
screen.

NOTE: When you choose to Remove a default Content Area (see table on page
4) any information stored within that area is deleted and cannot be
recovered!

Rename a Link/Button on the Course Menu

If you wish to rename an existing link, click the Modify button to the right of the link.
Type your preferred name for the link (maximum 18 characters) and click Submit.

Add a New Menu Link

You can use the Add toolbar at the top of the Manage Course Menu page to add a
new menu link of your choice.

Add CE% Content Area [P Tool Area  B=e Course Link @ External Link

1% See page 13 for details on linking directly to a specific folder or item within your
course.

To Change the Menu Style

1. From the Control Panel, select Settings from the Course Options box.

2. Select Course Design from the options displayed.

3. Select Course Design again from the smaller list of options.

4. Section 1: Select Navigation Style ¢ Buttons « Text

» Select Buttons or Text I 2 e i

Course Infarmation
Course Infornation

Staff Information

5. Section 2: Select Style Properties
» If you have chosen Buttons, you need to select a Button Type, Shape and
Style from the options displayed.

» If you have chosen Text, you need to click each Pick button in turn to choose
a background and text colour for your Course Menu.

Select background color for navigation: .
Select highlight color for navigation: (@wa )

6. When you have made your choices, click Submit.
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Getting Started with Blackboard

To Display a Course Banner (e.g. a departmental logo)

1. From the Control Panel, select Settings from the Course Options box.
2. Select Course Design from the options displayed.

3. Select Course Banner from the smaller list of options.

Select from the following:

Displays the banner that currently appears at the top

Current Banner
of the Announcements area.

Browse your hard/floppy disk drive to locate the

New Banner .
banner you wish to use.

Select this check box to remove the current banner

Remove this banner . )
image from the course website.

4. Click Submit.

To Include the Module Code in the Course Title

1. From the Control Panel, select Settings from the Course Options box.
2. Select Course Name and Description.

3. Click in the box to the left of the Course Title, type the module code and click
Submit.

To Make a Course Available/Unavailable to Students

From the Control Panel, select Settings from the Course Options box.
2. Select Course Availability.
3. Click Yes and Submit.

To Set Self-enrolment on a Blackboard Course

1. From the Control Panel, select Settings from the Course Options box.
Select Enrolment Options.

3. Ensure Self-Enrolment is selected, then tick the “Require Access Code to
enrol” check box and enter an Access Code.

Click Submit to finish the process.

Distribute the Access Code only to those whom you wish to enrol on the course.

Self-enrolling on a Blackboard Course (instructions for students)

1. Log on to UCC Blackboard http://blackboard.ucc.ie using your Student ID and
PIN.

Click the Courses tab.

Click Browse Course Catalog.

Type the course code or name in the Search box.

Once the correct course has been located, click the ENROL button to the right of
the course description.

If necessary, type the Access Code specified by your lecturer.

Click Submit to be taken to the course website.

abrwd

No
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Posting Announcements

1.
2.
3.

6.

From the Control Panel, select Announcements from the Course Tools box.
Click the Add Announcement button.

Type the subject and message, e.g. assignment due dates, clarifications, exam
schedules, etc.

Select a text type:

e Smart Text (recommended) is the default setting for message areas. It automatically
recognises links and accepts HTML tags.
e Plain Text displays text exactly as written.

e HTML displays text as coded if using HTML tags.

Section 2: Options Festrict dates to show this announcement:
(@) Permanent Announcement W Display After
Click Yes if you wish to always show this |[:|.:1 j |1Dj |2IIIII|5j

announcement on the course's main page

(661 [o0 =] [~ =]

OR
(b) Temporary Announcement I Display Until
Select dates on the calendar under Restrict |[:..j j |15j |2|;||;|5j
dates to show this announcement and tick
the relevant boxes if you wish to restrict the I 12 j |D':' j | i j

announcement to particular dates.

Click Submit.

Modifying/Removing Announcements

1.

From the Control Panel, select Announcements from the Course Tools box.

Announcements created within the last 7 days are listed according to date. You
may need to click another tab if your announcement was posted before then.

Select the announcement you wish to modify/remove and click

the relevant button. (_Modity ) (_Remove )

FPosted by UCC Blackboard

e Modify: make changes to your announcement as for Posting Announcements.

e Remove: a confirmation window appears asking if you are sure you want to
remove the announcement. Click OK to confirm or Cancel if you do not wish to
delete it.

2 Ensure you select the correct message before removing!
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Getting Started with Blackboard

Adding Staff Information Add £Z Falder [E3h Profile
1. From the Control Panel, select Staff Information from the Course Tools box.

If there are a few lecturers sharing a course, and a few demonstrators working with
students, then you can create separate folders for lecturers and tutors by selecting the
Add Folder button. Otherwise just click Add Profile for each lecturer.

e If adding a folder, select an appropriate folder name from the drop-down list, and
describe the contents of the folder in the Text box if necessary.

e Select Yes to make the folder visible to students, and click Submit and then click OK.

e If you have created a folder, click on the name of the folder before carrying out the
steps to add a profile below.

2. Click the Add Profile button and fill in the designated fields.
It is not necessary to fill all fields. Empty fields won't appear in the finished profile;
however an email address must be supplied.

3. Section 2: Options
e Choose to display/hide your profile by selecting Yes or No.

¢ Insert a photograph if desired: click the Browse button to locate the photo on your
floppy/hard disk, and click the Open button when you have selected the correct file.

e Link to a personal web page by typing the URL in the Personal Link box.

Current Image: Mone
Profile image: I Erowse... |
Personal link: |http:f,-’

4. Click Submit and then OK.

Adding Course Information

The Course Information area is used to post static information on a module, e.g.
course description, syllabus, objectives, exam dates, etc.

Add (T ltern CB% Folder @@% URL =k Course Link [Pl Test

1. From the Control Panel, select Course Information from the Content Areas
box.

Generally it isn’t necessary to create a folder in the Course Information area, however if
you intend to post a lot of information folders should be used to structure the material to
make it easier for students to navigate.

Click the Add Item button.

Choose a name for the item from the drop-down list, or specify a name yourself
by choosing Other - Add Text Below at the bottom of the list and type your
choice of title in the box provided, e.g. Exam Details.

4. Set a colour for the item name by clicking the Pick button and .
selecting a colour from the ColorPicker.

Learning Technologies Unit, UCC



Getting Started with Blackboard

5. Describe the contents of the folder in the Text box. The default Smart Text

setting is recommended.

File to Attach:

Marme of Link to File:

Special Action:

I Browse. . |
|

|Create a link to this file j

6. Section 2: Content Attachments

e Click the Browse button to attach a file if necessary.

e Inthe Name of Link to File box type the name of the link that students click
to access the attached file. TIP: type the name of the package used to create the
file e.g. Excel, so that students know what format it will be displayed in.

e Choose a Special Action from the drop-down menu.

Special Actions

Create a link to this file:

Selecting this option attaches the file to the Blackboard
document. A link is automatically inserted below the
document title to access the file.

Display media file
within the page:

Selecting this option embeds certain kinds of media within
the page itself instead of creating a link.

Unpackage this file:

This option indicates to the system that the file must be
unzipped before displaying it to the student. Large graphics
or animated files should be zipped prior to uploading to
Blackboard.

NOTE: If the file format is not supported by Blackboard, the
selections will default to Create a link to this file. If
students are to view the file correctly, they will need the
same package installed on the computer they use to open
the file.

5. Section 3: Options

Options

Do you want to make
the content visible?

Select Yes to make this item available for viewing when a
user accesses the Course Information page.
Select No to hide this item.

Do you want to add
offline content?

Select Yes or No to indicate whether users can view
content offline or not.

Do you want to track
number of views?

Yes will instruct the system to track the number of times a
user accesses this item. Use the Course Statistics page to
view these reports.

No will instruct the system not to record this information.

Do you want to add
metadata?

Choose Yes or No.
Meta-data is data about the added item, such as ownership,
resource format and copyright information.

Choose date
restrictions

Tick the Display After and/or Display Until boxes and set
dates of availability using the calendar interface (optional).

6. Click Submit and OK to acknowledge the receipt.
The item appears listed on the Course Information page.

Learning Technologies Unit, UCC




Getting Started with Blackboard

BUILDING YOUR COURSE

X% It is necessary to create Folders to structure Course Documents so it is
vital to think about information structure before starting to build your
course. This makes it much easier for students to navigate through posted
material. You may wish to create a separate folder for each term’s lectures,
or for each area of the course studied.

The ‘Add’ Menu Bar

Add (T ltem O3 Folder @3 URL [ Course Link [(AmTest @b [Leaming Unit

Lo Unn
SUREY
Assignrment
LEMN Fackage

Item Upload Course Documents, Lecture notes, Multimedia files, etc.

Creating folders to house Course Documents will enable easy navigation

Folder of your site for students.

Add a link to a website relevant to the subject material.
Note that it may be better to place all web addresses in the dedicated

URL External Links section of your course (Control Panel, Content Areas box,
External Links).
: Provide a shortcut to another area within your Blackboard course, e.g.
Course Link ; :
exam dates posted in the Course Information folder.
Test Create a link to a test you've already prepared that you wish to make

available to students.

Learning Units are similar to folders, in that they may contain several
documents or items, URLs and assignments. They differ in that they may
also contain quizzes and surveys. Students can follow a structured path
through content. Instructors have the option of enforcing a sequential
path or allowing students to access any page within the Learning Unit at
any time.

Learning Unit

Create a link to a test you've already prepared that you wish to make

Survey available to students.

Assignment Deploy a previously created assignment to students.

Microsoft LRN Content enables Instructors to create course content
presentations that have a hierarchical structure and sequential navigation.
Instructors can create LRN Content through the Microsoft LRN toolkit,
LRN Package which can be accessed from the Blackboard Learning System only if
installed on your computer.

For more information about the Microsoft LRN Toolkit, go to
http://www.microsoft.com/elearn/resources.asp.

Adding a Folder for Course Documents

1. From the Control Panel, select Course Documents from the Content Areas
box.

2. Click the Add Folder button from the options bar at the top of the page.

3. Choose a name for the folder from the drop-down list, or specify a name yourself
by choosing Other - Add Text Below, from the drop down list and typing the
name in the box, e.g. Lecture Notes.

.

Learning Technologies Unit, UCC
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Getting Started with Blackboard

4. Set a colour for the name of the folder by clicking the Pick button and selecting a
colour from the ColorPicker.

5. Describe the contents of the folder in the Text box. The default Smart Text
setting is recommended.

6. Section 2: Options
¢ Choose whether you want to make the folder visible by selecting Yes or No.

e If necessary, restrict folder availability by ticking Display Before/After and
selecting dates from the calendar.

7. Click Submit and OK to acknowledge the receipt.

8. The folder appears listed on the Course Documents page. If you click the
Folder Title (link) you will find it is empty.

Adding Course Documents

% When adding course content, especially PowerPoint Presentations please
select a light background and dark text to ensure that students will be able to
print these files if necessary. Avoid unnecessary graphics.

1. Open the folder to which you want to post a file, e.g. Lecture Notes, by clicking on
the folder title.

2. Select the content you wish to add from the Add menu bar. To upload lecture
notes click the Add Item button.

Select Other - Add Text from the drop down list.

4. Type the item name, e.g. Lecture 1, in the specify name box and describe the
lecture content briefly in the box below.

5. Section 2: Content Attachments
o Browse to attach a file if necessary.

¢ Inthe Name of Link to File box type the name of the link that users click to
access the attached file. You could also specify the file type here.

e Choose a Special Action from the drop-down menu.

Special Actions

Create a link to this file: | Selecting this option attaches the file to the Blackboard
document. A link is automatically inserted below the
document title to access the file.

Display media file Selecting this option embeds certain kinds of media within
within the page: the page itself instead of creating a link.
Unpackage this file: This option indicates to the system that the file must be

unzipped before displaying it to the student. Large graphics
or animated files should be zipped prior to uploading to
Blackboard.

NOTE: If the file format is not supported by Blackboard, the
selections will default to Create a link to this file. If
students are to view the file correctly, they will need the
same package installed on the computer they use to open
the file.

Learning Technologies Unit, UCC
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6. Section 3: Options

Options

Do you want to make
the content visible?

Select Yes to make this item available for viewing when a
user accesses the Course Information page.
Select No to hide this item.

Do you want to add
offline content?

Select Yes or No to indicate whether users can view
content offline or not.

Do you want to track
number of views?

Yes will instruct the system to track the number of times a
user accesses this item. Use the Course Statistics page to
view these reports.

No will instruct the system not to record this information.

Do you want to add
Meta-Data?

Choose Yes or No. Meta-data is data about the added
item, such as ownership, resource format and copyright
information.

Choose date
restrictions

Tick the Display After and/or Display Until boxes and set
dates of availability using the calendar interface (optional).

7. Click Submit and OK to acknowledge the receipt. The Item appears in the
relevant folder on the Course Documents page.

The following file types are recognized by the Blackboard Learning System.

Extension File Type Programs associates with the file type
.aam Multimedia Macromedia® Authorware® plug-in

.aiff Audio Audio program

.asf Multimedia Microsoft® .NET™ Show

.au Audio Real Audio Player™

.avi Video Video player (not Macintosh® compatible)
.doc Text Microsoft® Word® or other word processor
.ea Audio Java™ enabled Web browser

.ev, .ev2 Video Java™ enabled Web browser

.exe Executable

.gif Image Graphics program or Web browser

.html, .htm Web page HTML editor or Web browser

.image Image Graphics program or Web browser

.jpg, .jpeg Image Graphics program or Web browser

Jif Image Graphics program or Web browser

.mpe Audio/Video

.mpg, .mpeg Image Graphics program or Web browser

.moov Movie

.mov, .movie | Video Movie or media player

pdf Text Adobe® Acrobat® Reader®

.ppt, .pps Slide show Microsoft® PowerPoint® and PowerPoint Player®
.qt Movie QuickTime®

.ra Audio Real Audio Player™

.ram Video Real Audio Movie™

.swa Audio Macromedia® Shockwave® plug-in

.SWv, .Swf Multimedia Macromedia® Shockwave® plug-in

tiff Image Graphics program or Web browser

Ixt Text Text or HTML editor, word processor
.wav Audio Audio program

.wma Audio

.wmf Graphic Microsoft® Windows®

.wmv Media/Audio Microsoft® Windows®

.wpd Text WordPerfect® or other word processor
XlIs Spreadsheet Microsoft® Excel®

Learning Technologies Unit, UCC
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To Copy/Move Content within a Blackboard Course

Posted teaching material can now be copied or moved to another area within a
Blackboard course.

1. From the Control Panel, select Course Documents.

2. Click the Copy button to the right of the document or folder you wish to copy/move
elsewhere in your course.

3. Depending on whether you're moving a document or folder, the Copy/Move Content
or Copy/Move Folder page is displayed.

4. The actual document or folder is displayed in Section 1: Information.

Destination
Destination Falder: I Browse )
Delete item after copy? " ¥es Mo

5. Click the Browse button in Section 2: Destination and
select a destination folder for the item you are copying .
/moving from the pop-up window displayed. Select a location:

=
Refresh (=5 Open all B0 Close Al

6. If you wish to copy/ move the item to a sub-folder, click the

Bl intraduction to Blackbozrd
plus symbol to the left of that folder e.g. Course

Documents, and choose from the listed folders. € BH8 Course Information
All sub-folders can be viewed by clicking the Open All link £ BHE course Documents

at the top of the pop-up window.

. . i & Assignrnenis
7. Click the Submit button on the pop-up window, and the

destination folder name appears in the Destination Folder ¢ FHS Eaternal Links

box to the left of the Browse button.

8. Delete item after copy?
= If you are Copying the item, ensure the No radio button is selected.
= If you are Moving the item, ensure the Yes radio button is selected.

9. Click Submit at the bottom of the Copy/Move page.

10. Click OK on the receipt page to return to the folder you copied/moved material from.

To Create a Direct Menu Link to an Item/Folder

It is now possible for you to create a link on the Course Menu to a particular area/file on
your course.

1. From the Control Panel, select Manage Course Menu from the Course Options
box.

Click the Add Course Link button.  |E=Zs Course Link|

Type a short name for the link in the Area Name box.

Click the Browse button to locate the folder or item you wish to link to.

a M DN

Ensure the Make available for Student/Participant users box is ticked and click
Submit.

% Remove a link by clicking the Remove button to the right of the link on the Manage
Course Menu page.

Learning Technologies Unit, UCC 13



Getting Started with Blackboard

DISPLAYING POWERPOINT FILES ON BLACKBOARD

If you are posting images, sound, PowerPoint, Word, or PDF files on Blackboard, please
make sure that the files are of a reasonable size otherwise it makes it very difficult to
download/view them off-campus. It also uses up a lot of disk space unnecessarily. A 350
Mb file can take 5-6 hours download time on a dial-up connection!

IMPORTANT NOTICE

Details of how to resize images for screen use are available at:
http://www.ucc.ie:8080/cocoon/cc/elec-pub/graphics.

Please convert PowerPoint slide shows to Word format to make printing easier for
students. Both the PowerPoint and Word versions can be displayed in Blackboard
giving the student the choice to view the online version or the printable version.

To Convert PowerPoint Files to Word Format

1.

Open the PowerPoint presentation as saved on your own computer. Don’t open
the file via Blackboard.

From the File menu, select Send to, and select Microsoft Word from the sub-
menu.

A pop-up dialog box appears, asking you to choose the format in which you wish
the presentation to be displayed in Word:

—Page lavout in Microsoft Word

e Choose Blank lines below slides.

. . W5 .

The other options are unsuitable for our purpose. = @ s (o s
e Also choose Paste under Add slides to Microsoft =§ " Blank lines next to slides

Word document. i

. . . W!W " Mokes below slides

Click OK to convert your file to Word format. This i
process creates a separate Word file and your original B i beiow sid
slide show remains unaffected. = ani ines helow sldes
In Word, delete the blank lines and slide numbers to fit =| © Outlne orly

three slides on each page.
—#Add slides to Microsoft Word document —

¥ Paste

Save the Word file and upload it to Blackboard in the ~ ,
Paste link

usual manner, labelling it as a “printable version” of
the slide show.
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Testing Course Links

1.

If you wish to see your course from a student’s perspective, click on the Module
Title in the navigation path at the top of your screen to return to the main course

view.

UCC Blackboard

Courses

Acaderic Web Resources

COURSES » INTRODUCTIOMN TO BLACKBOARD > COMTROL PAMEL » COURSE DOCUMENTS

From the button bar, select the area to which you have just posted a file e.g.
Course Documents and click the Lecture Notes folder; then select the lecture

title.

Depending on your browser, it may open the document within the Blackboard
screen, in an external window or it may prompt you to save the file locally before

viewing.

Adding Learning Units

Learning Unit content is managed in much the same way as content in Course
Documents, with one exception: Learning Units cannot contain folders.

1.
2.

From the Control Panel, select Course Documents.
Select Add Learning Unit from the drop-down list on the right of the Add menu
bar, and click the Go button.

Choose a name for the Learning Unit from the drop-down list or select Other —
Add text below and specify your own name underneath.

Describe the unit, or list instructions for your students to follow in the Text box
underneath the title, e.g. “These units must be read in sequential order’.

Section 2: Options

Options

Do you want to make
the Learning Unit
visible?

Select Yes or No to indicate whether to make the Learning
Unit available to students. Instructors and staff will still be
able to access the unit via the Control Panel.

Do you want to enforce
sequential viewing of
the Learning Unit?

Select Yes if you wish students to view units in the order
listed. They will not be able to advance to a page without
having viewed a previous page.

Select No if you wish students to view units in any order.

Do you want the
Learning Unit to open in
a new window?

Yes will instruct the unit to open in a new browser window.
No will open the unit in the current browser window.

Do you want to track
number of views?

Yes will instruct the system to track the number of times a
user accesses this item. Use the Course Statistics page to
view these reports.

No will instruct the system not to record this information.

Do you want to add
metadata?

Choose Yes or No.
Meta-data is data about the added item, such as ownership,
resource format and copyright information.

Choose date
restrictions

Tick the Display After and/or Display Until boxes and set
dates of availability using the calendar interface (optional).

Learning Technologies Unit, UCC
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Click Submit and OK to acknowledge the receipt. The Learning Unit appears
on the Course Documents page.

Open the Learning Units folder.

Select the Add Item button. This option allows you to attach a file and include a
description of the file/instructions for students.

See Adding Course Documents steps 3-7 (on page 11) to add a file.

Adding Multimedia Files

1.

2
3.
4

From the Control Panel, select Course Documents.

Add a new folder entitled Additional Materials.

Open the folder and click the Add Item button.

From the Name box, select Other — Add text below and type Video
Demonstration in the Specify your own name box.

Describe the multimedia clip in the Text box underneath the title.
Section 2: Content Attachments

o Browse to attach a file if necessary.

¢ Inthe Name of Link to File box type the name of the link that users click to
access the attached file. You could also specify the file type here.

e Choose a Special Action from the drop-down menu.

Special Actions

Create a link to this file: | Selecting this option attaches the file to the Blackboard
document. A link is automatically inserted below the
document title to access the file.

Display media file Selecting this option embeds certain kinds of media within
within the page: the page itself instead of creating a link.
Unpackage this file: This option indicates to the system that the file must be

unzipped before it is displayed to the user.

NOTE: If the file format is not supported by Blackboard, the
selections will default to Create a link to this file.
Supported digital media formats are:

« Graphics: GIF, JPEG

« Video: MPEG, Quicktime, AVI

« Audio: WAV, AIFF

« Multimedia: Shockwave Flash

Cont/d...
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7. Section 3: Options

Options

Do you want to make
the content visible?

Select Yes to make this item available for viewing when a
user accesses the Course Information page.
Select No to hide this item.

Do you want to add
offline content?

Select Yes or No to indicate whether users can view
content offline or not.

Do you want to track
number of views?

Yes will instruct the system to track the number of times a
user accesses this item. Use the Course Statistics page to
view these reports.

No will instruct the system not to record this information.

Do you want to add
Meta-Data?

Choose Yes or No.
Meta-data is data about the added item, such as ownership,
resource format and copyright information.

Choose date
restrictions

Tick the Display After and/or Display Until boxes to choose
dates of availability (optional).

8. Click Submit and OK to acknowledge the receipt. The Item appears in the
Additional Materials folder on the Course Documents page.

Re-ordering ltems

1. To change the order in which items are
displayed, click the arrow next to the title and

choose a number.

Modifying Content

1.

gl

2_;l Video Demonstration

1 arking ¢ Package file )
ideno demonstrates how to p4

Click the Modify button next to an item, e.g. Video Demonstration

You may wish to add further text, e.g. This media clip will automatically open in
the media player on your computer.

Click Submit and OK.

Removing Content

1.

Press the Remove button next to the item you wish to remove, e.g. Additional

Materials.

You will be prompted Are you sure you want to remove this item? Click OK if

you wish to remove it.

Folders can be removed as easily as individual items, even
when they are full of content so use this option carefully!!!

CAUTION!

Learning Technologies Unit, UCC
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Assignments

Assignments can be managed in the same way as course content via the Control
Panel. Select Assignments from the Content Areas section and proceed as for
adding course content.

Adding External Links to your Course

1.

2
3.
4

Click Control Panel from the button bar on the left.

Under Content Areas, select External Links.

Click Add URL on the Add menu bar.

Enter the name and URL for the page to which you are creating a link. Describe
the link briefly for students.

If you wish the link to open in a new browser window, click the Yes radio button
alongside Launch item in external window. Selecting Yes is recommended so
that students can refer back to their Blackboard course whilst browsing the external
link if necessary.

Click Submit and OK. The link is now listed under External Links on the course
website menu.

COURSE CALENDAR

Instructors can use the course calendar to indicate important course related events.
The dates and events that appear on the Course Calendar can be viewed by all
students enrolled on that course.

Adding Events to the Course Calendar

1.

2.
3.

From the Control Panel, select Course Calendar from the Course Tools box.

Click the Add Event button. | [t Add Evert

Enter a name and description for the event in the relevant boxes, e.g. Visiting
Speaker.

Use the drop-down arrows on the date ) - - = i
selector to choose the date, start and Event Date: INDV J IDB J IZDDE J
end time for the event. Event Start Time: [10 »| |00 =] [AM =]

Click Submit and OK. Event End Time: |11 »| |00 =] [AM =]
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To View Events on a Particular Day

1.

From the Control Panel, select Course Calendar from the Course Tools box.

Click the Quick Jump button. Guick Jump

Use the drop-down arrows to select the date you wish to view, and then choose
whether you wish to see a Monthly, Weekly or Daily view.

Click the Submit button. The calendar is displayed according to your request.

Click on an event from the listing for further details.

To Modify an Event

Display the event using the Quick Jump button as detailed previously.
Click the Modify button next to the entry.

The Modify page is exactly the same as the Add Event page and all details
already entered are displayed.

Make changes as necessary and click Submit.

To Remove an Event

E A

Display the event using the Quick Jump button as detailed previously.
Click the Remove button next to the relevant event.
A warning box will be displayed asking if you want to remove the event.

Select OK or Cancel. Removing an event is irreversible.

Learning Technologies Unit, UCC
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SENDING EMAIL WITHIN BLACKBOARD

Instructors can use Blackboard to send email to individuals participating on their courses
and, if enabled by the instructor, students can email their fellow students. Students
must be notified that all email sent via Blackboard will be sent to their UCC student
email accounts.

To minimise the distraction of long lists of To: addresses, and to make the reuse of
address lists more difficult for potential spammers, all destination addresses are placed
into the email’s Bcc: (Blind Carbon Copy) field upon receipt.

To Send an Email within a Blackboard Course

1.
2.

o g M~ W

From the Control Panel, select Send Email from the Course Tools area.
Select one of the options on display:

« All Users: email all users enrolled on a Blackboard module.

« All Groups: email all groups created within a module.

. All Teaching Assistants: email all teaching assistants on a module.

« All Instructors: email all instructors on a module.

. Single/Select Users: email single or select users enrolled on a module.

. Single/Select Groups: email a single group or select groups within a module.

If you choose one of the All options, the Send email page of your choice is
displayed, listing the selected user(s) in the To: field.

If you choose one of the Single/Select options a list of enrolled users is
displayed for you to choose from. Tick the box next to the name of each person
you wish to email.

The Instructor’s email address is automatically listed in the From: field.

Type a subject for the email in the Subject box.

Type the email content in the Message box.

If you would like to receive a copy of the email, tick the Send Copy of Message
to self box.

If you wish to add an attachment, click the Add button in the attachments (Add )
section, Browse to locate the file you wish to add, and then click OK.

Click Submit to send the email.

Disabling the Email facility on a Course

The Send Email facility is enabled by default on all Blackboard Courses.

Send Email can be disabled from the Control Panel of a course by selecting
Manage Tools from the Course Options box, then selecting Enable
Blackboard Tools.

Scroll down through the listings to Email (Tools are listed alphabetically).

Remove the tick from the box opposite Email and Submit your choice.
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DISCUSSION BOARDS

Blackboard's Discussion Board facility is designed to encourage communication between
students and staff. All messages are displayed in a threaded discussion format and
can be easily archived for future reference. Messages may be posted anonymously
depending on the forum options chosen at the time of creation.

Students can also be given the right to administer individual forums. Once a student has
been given administrative rights to the forum, he/she has the same rights as the
instructor of that forum. However, the student cannot remove the instructor from the
forum.

Creating a Forum on the Discussion Board

1. From the Control Panel, click on the Discussion Boards link under the heading
Course Tools.

2. Click the Add Forum button, and then enter the forum Title and

Description. Forum Settings:

3. Choose the appropriate Forum I Allow anonymous posts

Settings and then click Submit I Allow author to edit message after posting

to create the forum. ™ Allow authar to remave own posted messages

NOTE: Allowing file attachments ™ Allow file attachments
is not recommended.

¥ Allow new threads

4. Click the forum title to enter the forum and read/post comments.
|1 x| Getting Started with Blackboard

=hare your impressions of Blackboard here.

Forum User Settings

1. Highlight a user and click the appropriate button to assign specific rights as
described below.

Forum User Settings:
a = Forum Administrator privileges
&= Permanent Forum Administrator
t = User is blocked from posting

ADMIN | NORMAL

& Blackboard, UCC (blackboard)

student, a (a.student)

BLOCK | UNBLOCK

Forum User Settings

Revokes the forum administrator privileges to a selected user, e.g. a
Normal particular student who may have been appointed temporary
administrator.

Assigns forum administrator privileges to a selected user.
« A =permanent forum administrator, i.e. the person creating the
Admin forum. No one can take away these privileges.
« a = Administrator assigned by the permanent forum administrator,
e.g. a student/co-instructor/teaching assistant.

Blocks a user from posting to the discussion board forum. Only an

Block administrator can block a user.

Unblocks a user who was formerly blocked from posting to the

Unblock discussion board forum.
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Posting Messages to the Discussion Board

1.
2.
3.

Replying to a Message on the Discussion Board

Once in the forum, click the Add New Thread button to start a thread.

Enter the Subject and Message for the thread.

[E=u Add New Thread

Depending on the forum settings, there may be an option to post the message

anonymously. Tick the box if you wish to do this.

™ Post message as Anonymous

Click Submit to post the message.

Click on the subject to view the full message.

= The title of the posting is displayed along with the author's name or “Anonymous”

and the date and time of posting.

= Unread messages appear in bold text and may be accompanied by a New icon.

1.

Sorting Messages

Click the Communication link from the course 3 Discussion Boards

menu, and select Discussion Boards.

Click on the Forum you wish to access.

Read through the postings and when you wish to respond to one, click
the Reply button to the lower right of the message.

Enter your message as before and click Submit.

= Note how the subject line automatically refers to the previous message and also

how the threaded messages are displayed

Use the Sort By: drop-down list to sort messages in a forum.

Discussion Board Toolbar

The Discussion Board toolbar can be viewed from within a forum

by clicking the Show Options tab.

SHOW OPTIONS

W = W
T PR = 8 & O
ZELECT ALL| WUMZELECT IMWERT FEAD UMREAD COLLECT LOCE UMLOGHE FREMOWE
Fs

Options Buttons
Select All Select all threads and messages in the forum.
Unselect Unselect the selections.

Reverse the current selection. (Unselect the selected items and select those
Invert .

items that have not been selected.)
Read To mark messages as read, select the threads and messages and click

Read.

To mark messages as unread, select the threads and messages and click
Unread

Unread.
Collect To view multiple threads and messages select them, then click Collect.
Lock To lock messages so they cannot be read, select them and click Lock.
Unlock To unlock message so they can be read, select them and click Unlock.
Remove To remove items from a forum, select them and click Remove.

Availability of these options depends on the Forum Settings.
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To Create a Discussion Board Archive

1.
2.
3.

4.

5.

|[ Click Here for Archives | |

Select the Click Here for Archives link. = :

Click the Add Archive button.

Enter an Archive Title and Description, making sure the Title and Description
suitably describe the topic of discussion.

Archive Title: |Getting Started with Blackboard

Description:

Early EBlackboard comunents.

% Srnart Text © Plain Text ¢ HTML

fwailable: ¥ The archive and its messages are available to students

Tick the Available box if you wish students to be able to read the archive and its
messages.

Click Submit to create the archive.

The archive is empty when it is initially created. Note how it contains [No Messages].

[1=] Getting Started with Blackboard (_Modity ) (_Remove )

Early Blackboard comments. [ Mo Messages |

To Move Messages from a Forum into an Archive

1.
2.

o > w

Click the Modify button.

A list of threads is displayed under the heading ~ |Select threads to move to Archive
Select threads to move to Archive. r first impressions

Click on the check box next to each main thread you wish to archive.
Click Submit. Only the checked messages will be moved into the archive.

Click on the archive name to view the contents of the archive. Messages appear
in the archive in the same format as in the forum.

To Return an Archived Thread back onto the Discussion Board

A

r W

Click the Modify button.

A list of archived threads is displayed under the  |Release archived thread into Forum
heading Release archived thread into Forum. r first impressions

Click on the check box next to each thread you wish to return to the forum.

Click Submit. Only the checked messages will be returned to the forum.
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MANAGE TOOLS

By default all Tools are made available within a course when it is created on Blackboard.
Tools you don't intend to use with students can be made unavailable by selecting
Manage Tools from the Course Options area of the Control Panel.

Blackboard Tools appear directly on
m Manage Tools the Course menu of the Courses Tab,

or within areas of the Course menu,
e.g. the Digital Drop Box for students

N is located under the Tools link/button
Enahle Blackbhoard Tools on the Course menu.

Enable tools provided by Blackboard.

Extension Tools are not currently in

P Enable Extension Tools use within UCC Blackboard.

Enahble tools pravided through system extensions)

P Enable Content Tools Content Tools represent different
types of content that can be added to a
course, e.g. a URL, test or survey.

Enable content tools.

Click on one of the available options under Manage Tools to access the relevant
management page. All Tools are made available on the system by default. If a tick box
next to a tool is empty, then the tool is unavailable within that course.

= To make a tool available, click the box so that a tick appears, and click Submit.

= To make a tool unavailable, click the box to remove the tick, and click Submit.

NOTE: The Allow Guest column should be ignored as Guests (those without UCC
Blackboard accounts) are not allowed to logon to the system.

COURSE SETTINGS

Select Settings from the Course Options area of the Instructor Control Panel to
access the Course Settings page. Click a link to modify one of the listed options as
detailed below.

Course Name and Description

Course Name displays the module title. Official course names must be used in
accordance with the UCC Book of Modules.

Description describes the course in accordance with the UCC Book of Modules (see
Content heading).

Course Categorisation gives you the opportunity to select a subject area and discipline
to best describe your course.

Course Availability

This link allows you to control whether your course is visible to students or not.

It is recommended that you make a course unavailable whilst preparing it for use. When
ready, it can be made available on the system by selecting the Course Availability link,
then clicking Yes and Submit.

Guest Access

Guest access to UCC Blackboard is not permitted therefore this option cannot be
modified. Guest refers to external users without an account on the system.

...continued overleaf
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Course Duration

It is recommended that you retain the default setting of Continuous for your course.

For distance learning courses, it is possible to set a start and end date for the course, or
to make a course available for a set number of days from the date of enrolment.

Click the appropriate radio button and set the start and end dates using the calendar
displayed, or type the number of days for which the course will be available to the student
and then click Submit.

Enrolment Options

We recommend that you select the self-enrol option on your course and set a password
so that only those you give the password to will be able to enrol.

Setting Self-Enrolment on a Blackboard Course

1. From the Control Panel, select Settings.

2. Select Enrolment Options.

3. Ensure Self-Enrolment is selected, then tick the “Require Access Code to enrol” check
box and enter an Access Code.
¥ There is no need to set a Start and End date for your course.

4. Click Submit to finish the process.

5. Distribute the Access Code only to those whom you wish to enrol on the course.

Self-enrolling on a Blackboard Course (instructions for students)

Log on to UCC Blackboard http://blackboard.ucc.ie using your Student ID and PIN.
Click the Courses tab.

Click Browse Course Catalog.

Type the course code or name in the Search box.

Once the correct course has been located, click the Enrol button to the right of the
course description.

If necessary, type the Access Code specified by your lecturer.

Click Submit to be taken to the course website.

agrLONE

No

Categorize Course

Categorisation of courses is not currently in use on UCC Blackboard.

Set Course Entry Point

The default course entry point is the Announcements page. You may prefer your
students to access another area when they enter your Blackboard course.

To select a new course entry point, select an area from the drop-down list and click
Submit.

Course Design

Manage the appearance of your Blackboard course by selecting a menu style and colour
(page 5), and by uploading a departmental logo (page 6).

Observer Access

Observer facilities are not available within UCC Blackboard.

Learning Technologies Unit, UCC
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WebEQ Equation Editor (Maths & Science Notation Tool)

Blackboard now provides a general purpose equation editor to enable use of
mathematical and scientific notation throughout Blackboard. All of the Equation Editor
symbols are based on MathML, a mark-up language for maths on the Web.

& Smart Text © Plain Text ¢ HTML (&) @)\(ﬂﬂ

WebEQ Equation XML Editor button (for
Editor button those familiar with XML)

1. Open the WebEQ Equation Editor by clicking the WebEQ Editor button underneath
the Text box when adding an Item to your course.

EJ webEQ Equation Editor

=l

Edit Equation. [—— Choose Equation

Equation Name: |

Font size: |15 "I Adjust width: |1IZIEI% "’I Adjust height: |1IIIIII?«£. 'I

Eauation Toolbar

Powered by T Add ) Modify )  Cancel )

2. Click a button on the equation toolbar in the pop-up WebEQ
window to display a drop-down menu of options relevant to -
your choice of symbol. o

3. Arred vertical bar indicates where your typed text will appear.

B

When you have completed your equation, click the Add
button on the pop-up window.

5. A reference to your equation is displayed in the Text box.
Making changes to this reference will disturb the build of your
equation.

6. To see how the equation will appear following submission, click the Preview button
under the Text box.

~

Fill in or select any other relevant details on the Add Content page before clicking
Submit.
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BLACKBOARD HOUSEKEEPING

Create a back-up copy of your course regularly in case you accidentally remove
an important element. This could save hours of work locating and re-loading lost
material.

We recommend you create a Blackboard Archive folder on your own computer for
any archive files created, so that you'll be able to locate your back-up files easily
when required.

BACK-UP YOUR COURSE!

From the Control Panel of each course select Archive Course from the Course
Options box.

Destination Course ID: ‘ModuleCode' is displayed. Click Submit.
Click the link indicated on the Receipt page to download the file to your own

computer.

Choose the folder into which you will save the file (see above), then click the
Save button on the dialog box displayed. Make sure you add a date to the
filename for your own records.

If you are no longer teaching a particular module, but may teach it again in the future,
please archive your course as above, and inform the Learning Technologies Unit
(Ltu@ucc.ie) so that we can remove it from the system, or prepare it for the lecturer
who may be teaching it the following year.

PLEASE NOTE

Recycle Your Course

Each September it is important that you ‘recycle’ the students enrolled on your
course to make way for incoming students. It is also possible to ‘recycle’ other
course areas, e.g. Discussion Boards, etc.

1.

Login to each Blackboard module you are teaching in turn.
From the Control Panel select Recycle Course from the Course Options box.

Click in the boxes to the left of those areas you wish to recycle (ticking Users will
unenrol last year's students). A tick confirms your selection for recycling.

Type Remove (case sensitive) in the box displayed at the end of the page and
click Submit.

These changes are irreversible so double-check your selection before clicking
Submit.
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